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Leica TCS SPE-II index  
 

Preface:  

 

This handout will by no means cover all the imaging possibilities of the SPE. Detailed outline of its 

functionality will be in the help files of the LAS-AF software. This quick start is to get you going for 

the first imaging procedures and will be enough for most of you. Please consult the help files or 

contact the staff to expand your knowledge.  

 

Kind regards, 

 

Richard Wubbolts (r.wubbolts@uu.nl, 030 2534308) 

Esther van ’t Veld  (e.m.vantveld@uu.nl, 030 2537704) 

Rob Bleumink (a.r.j.bleumink@uu.nl, 030 2535296) 

 

Visiting address:  

Faculty of Veterinary Medicine, Utrecht University 

Department of Biochemistry and Cell Biology 

Androclus Building, Yalelaan 1, 1
st

 floor- east wing   

3584 CL Utrecht 

Web: http://bc-uu.nl/cci/ 
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Leica TCS SPE-II handout:  

 

Starting the system:  
!!!!! the automated xy table will initialize during this procedure, be sure to move 

condenser and objective out of the way to prevent the  table crashing up to them!!!!!  

1. Toggle switch >on fluorescence lamp  

2. Turn on microscope controller  

3. Turn on laser control box 

4. Turn on PC/monitors (top button right) and log on using:  

CCI user   

 

5. Allow laser emission by turning key switch  

6. Start LAS-AF software by clicking [       ]  
7.  “OK” to start initializing sequence 

8. “YES” to initialize microscope xy stage 

 (!!!! Beware of the danger to crash the rapid moving table to 

the condenser and objective- move them out of the way!!!!) 

9. In the configuration tab:  

- Switch on the laser diodes you need by checking the 

different boxes (laser icon 9a) 

- Optional: set panel box buttons to desired sensitivity 

(Panel box icon 9b) 

- Optional: set 8 bit to 12 bit 

(Setting tab icon 9c) 

  

  1 

   2   3 

   5 

   9 

  9a 

  9b   9c 
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Overview of LAS windows: 
 

 

 

  Image dimension 

setting 
Beam path setting 

 

Start/stop controls 

 

Channel/Overlay view 

 

Serie view 

 

Channel/Overlay 

properties 

 

- Annotate 

- ROI 

- Scale 

- Zoom 

- LUT 

 

Image control: 

-View/hide 

- Play / Scroll 

- Overlay 

- Ortho 
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Layout of the acquisition window: 

 

 

 

 
  

  
Tab: Experiments 

Toggle: matrix scan / multiple position  

Toggle: Seq >> allows multiple dye imaging 

(scan1, scan2 etc.) 

Hyperlink: dichroic mirror selection 

Hyperlink: show transmission detector  

(View changes into ↓) 

Triangle: open submenu ↓ 

Dropdown: saved  settings 

Active laser AOTF setting (non-greyed)   

Slider: emission filter setting 

!! Active laser line is visible and should not overlap 

with slider!!  

Stack settings: xyz acquisition mode  

- set top/ bottom (toggle blocks –black moves along with focus, yellow sets 

position) 

- Set step/nr slices etc to define stack sampling 

Imaging start: Live = preview active channel / Capture = capture of active channel / Start = capture all channels 

Zoom to ROI: Allows zooming to ROI while scanning  
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Lay out of the viewing window 
  

Toggle: show LUT presets  

(View changes into ↓ -BW    ↓↓ -Active LUT             ↓↓↓ QuickLUT (0= green / max=blue) 

Toggle: view/hide channel (see pics) 

Toggle: view/hide overlay 

Toggle:  
- max projection (bottom pics) 
- orthogonal view (right pics) 
- slice view (large pic) 
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Acquisition:  
1. Click acquire tab 

2. Acquisition tab will be active 

3. Multiple color imaging: click seq and repeat setting for 

detecting each fluorochrome separately 

4. Default scan format: XYZ (512x512) 

5. scan settings are displayed, pop window open by clicking [] 

- pinhole default = 1 airy disk (tick to change 5a) 

- Combined zoom and format determine ultimate pixel 

size. They should match the optimal sampling criteria 

for the chosen objective (NA, immersion, Nyquist) 

- scanning speeds (bidirectional scan requires phase 

adjustments, pop up slider) 

- panning (5b) is not advised since the xy table in fine 

setting can do this (and imaging occurs using the centre of the objective) 

- Frame average reduces recorded noise, accumulate increases signal (also noise!!) 

 

Beam path setting:  

6. Click on Visible (6)  to view the beam path  

- (grayed means laser is not on => config to turn on) 

7. Single or multiple dye detection:  

- Single dye: SEQ (7a) toggled off in 

acquisition tab 

- Multiple dyes (7b): Scan 1,2 etc. should be 

set separately (+ add channel, - remove) 

- default settings in drop down menu  (check) 

• single (7c): single dye settings visible 

• seq (7c): multiple dye detection setting visible 

8. Adjusting setting to your needs:  

a. Show emission spectrum of the dye (preset graphs in dropdown list 

will show up in the rainbow panel) 

b. Fit spectral detector slider width emission (click on it to type  

settings), avoid overlap with exciting laser line (vertical line in 

rainbow panel) 

c. Check dichroic (QD 405/488/561/635 should do fine in most cases) 

d. Choose suitable Look Up Table (LUT) 

e. Select Live to continuous preview active channel 

f. Actual PMT setting involves tuning: (Use QuickLUT in viewer window to set properly) 

- Laser power (fitting excitation of dye) (8f1) 

- Gain / Offset: panel box buttons (8f4) (click PMT1, (8f2) to activate controls 

(8f3))  

- Scan speed (pixel dwell time) 

- Check selected PMT settings in different focus planes (Z positions) 

 

SEQ ON 

 

5 

5b 

5a 

6 

7b 

7a 

7c 

8a 

8b 

8d 

8c 

8f2 

8g 

8f1 

8f3 
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g. Toggle transmission channel on if wanted (2nd PMT Trans 

will pop up)  

h. BF / DIC / DIC-pol can be chosen (adjusting properly will 

pay off)  

Tip: DIC-pol needs to be optimally set on microscope before imaging 

Tip: DIC-pol recording in separate channel and severe gain/offset setting improves picture (grey LUT works best 

for tuning, PMT Trans should be clicked to activate this setting, 488/561 nm laser lines provide best DIC images) 

- Note: Detection is sensitive to TL light (60 Hz, diamond like interference pattern).  

 

 

Tip: Panel box small buttons on left are useful for quick switching between channels.  

Most left (10) –toggle smart gain window / right (11) – start/stop scan 

 

Acquiring an image: 

9. Select Capture button to capture the active channel  

Select Start button to capture all channels 

 

Save your image to the data disk in the experiment tab. 

- Images are saved as .lif (Leica image file) exporting files to .tif is optional 
- By selecting the experiment folder using the right mouse button a dropdown menu will appear with 

further options for saving and renaming your experiment. 
- By selecting an individual image in the experiment folder using the right mouse button a second 

dropdown menu is activated to view the used settings for the image. 
 

  

10 11 
8f4 8f4 
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Stack acquisition: 
 

1. Acquire tab > Acquisition 

2. Select scan mode: XYZ 

3. Select LIVE to preview 

4. Optimize xy settings as described above   

5. Move z-position (use panel box or click Z-‘cube’ (5) and drag the planes or 

use mouse wheel, click Begin [] or End [] mark) 

6. mark   is free to move along with microscope Z-control, while  depicts 

a mark that is stored and fixed for use in stack acquisition (toggle to reset values) 

7. A plane can be selected (6) to go back to easily (7) or to use in focusing protocols. 

8. Bottom panel describes the volume sampling parameters, optimize 

automatically using standard system settings or define step size/nr of steps 

yourself. System optimized settings often lead to very large stack sizes. 

Correct settings can be calculated from section thickness (XY panel => 

activate section thickness link (8b, set proper emission wavelength), optimal 

step size should approximate this value divided by 2.3 (to meet the Nyquist 

sampling criterion)).  

9. Click compensate to alter laser power during stack acquisition 

10. START to acquire stack 

11. Rename  “Serie…(…MB, xyz)”  by right click and rename, then save 

 

3D Projection of stacks: 
Stacks can be visualized as: slice view, galleries, orthogonal slices or projections (still or rotated).  

The viewer window allows exploration by slice, maximal projection (top view) and orthogonal 

view (see above). More extended projections en rendering are performed in the process tab. 

Note: projections are additions to original .lif files; the Experiments tab will show an asterisk at the top and 

beside the file when these edits are performed but are not saved, SAVE to prevent loss. 

1. Select experiment, click on Tools tab 

2. Optional: Sub selection of stacks can be performed (crop, internal top/bottom and slice skip) 

3. To animate 3D renderings, start-end angles and step sizes can be defined (refer to help and 

try to get optimal result, maximal projections usually do fine)  

4. !! This takes calculating time of the acquisition PC which can be performed on an off line 

station as well.  

  

5 

6 7 

8 

8b 
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Shut down: 
1. In experiment tab right click on experiment file to rename  

NB: think of names that will allow you to find files in general file managers 

NB: Files not secured can be lost, when files are edited they will be marked by * until they are 
saved    
Backup your files after imaging to a USB drive. The data disk is cleaned regularly. 

2. Tick ‘off’ laser lines in configuration tab 

3. Close LAS-AF 

4. Clean the objectives  

5. Lower the objective and tilt transmitted light arm backwards   

6. Laser key switch to position “0”, power off laser box 

7. Shut down  PC 

8. Shut down microscope controller 

9. Shut down fluorescence lamp 

10. Place the dustcover over the microscope 

 

 
*This handout was created by dr. Richard Wubbolts and ing. Esther van ‘t Veld. Parts were edited from a SP5/LAS-AF 

handout provided by Patrick van Wieringen (Leica Microsystems).   

 

Image viewing on other computers:  
 

 A free version of the software is available from Leica: LAS AF lite - 
ftp://ftp.llt.de/softlib/LAS_AF_Lite/ 

This is a program with limited functionality, but fine for quick viewing data, exporting to common file 
formats and simple quantification.  
 

 A brochure on the HCS-A matrix screening module can be downloaded at http://www.leica-

microsystems.com/fileadmin/downloads/Leica%20HCS%20A/Brochures/Leica%20HCS%20A-

Brochure_EN.pdf. The staff and help file can guide you through the steps to perform the 

acquisitions.  

 

 We recommend learning ImageJ originally developed by Wayne Rasband (NIH) to perform 

image analyses. This is a platform independent software package developed by a very active 

open source community. Good packages can be installed (and appended with freely available 

plugins) from:  

- NIH: http://rsb.info.nih.gov/ij/index.html 

- MBF http://www.macbiophotonics.ca/imagej/installing_imagej.htm 

- FIJI: http://pacific.mpi-cbg.de/wiki/index.php/Fiji 

Manuals: http://www.macbiophotonics.ca/imagej/ ,  

WIKI: http://imagejdocu.tudor.lu/ 

 

ftp://ftp.llt.de/softlib/LAS_AF_Lite/
http://www.leica-microsystems.com/fileadmin/downloads/Leica%20HCS%20A/Brochures/Leica%20HCS%20A-Brochure_EN.pdf
http://www.leica-microsystems.com/fileadmin/downloads/Leica%20HCS%20A/Brochures/Leica%20HCS%20A-Brochure_EN.pdf
http://www.leica-microsystems.com/fileadmin/downloads/Leica%20HCS%20A/Brochures/Leica%20HCS%20A-Brochure_EN.pdf
http://rsb.info.nih.gov/ij/index.html
http://www.macbiophotonics.ca/imagej/installing_imagej.htm
http://pacific.mpi-cbg.de/wiki/index.php/Fiji
http://www.macbiophotonics.ca/imagej/
http://imagejdocu.tudor.lu/
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Reading Lif files into IJ using LOCI image reader  
(credits: depts.washington.edu/if) 

Components needed 

- ImageJ (download from ImageJ website)  

- loci_tools (download from LOCI website)  

Procedure 

1. launch ImageJ/Fiji 

2. drag and drop the lif file onto ImageJ's status bar to open the file 

3. Loci_tools' Bio-Formats Import Options dialog box will open  

4. for Stack Viewing, set View stack with: Hyperstack 

5. under Color options, check Autoscale if you want to use the min and max intensity values 

stored in the image 

6. click OK and wait for loci_tools' Bio-Formats Series Options dialog box which allows 

selection of specific contents 

7. select the desirable images and click OK 

8. the plugin re-scales 12 bit data to 16 bit data  

NB: if omitted 16-bit files with 12-bit resolution will appear dark unless the intensity is scaled. e.g., set 
Minimum displayed value to 0 and Maximum displayed value to 4095 for full scale display  

 
9. You can always do this manually as well: Do Image > Adjust > Brightness/Contrast... 
10. click on Auto to use the min and max intensity values stored in the image or click on Set 

and enter the desirable displayed values.  

11. Some software cannot deal with 16-bit files, you can convert the image to 8-bit by doing 
Image > Type > 8-bit 

 

Multidimensional files 

 sequential multichannel file opens correctly using View stack with: Hyperstack 

 simultaneous multichannel file  

1. need to use View stack with: Standard ImageJ and Stack order: Default (xyzct) 

2. convert the opened stack to hyperstack, do Image > Hyperstack > Stack to hyperstack..., 

use the default xyczt order and fill in the appropriate c, z, t value 

 

Other simple tasks 

 if you want to break down the multidimension series e.g., XYCZT  

1. do it during file open with the Split into separate windows options  

Split channels, focal planes, timepoints 

2. after the image series is opened as a hyperstack, you can do Plugins > LOCI > Stack Slicer 

and check the appropriate options. 

 

An ImageJ macro is available that allows quick formation of ‘thumbnail prints’of your .lif imaging 

data, ask the staff for further information. 

  

http://depts.washington.edu/if/index.shtml
http://rsb.info.nih.gov/ij/download.html
http://www.loci.wisc.edu/bio-formats/imagej
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Technical appendix 
 

1. Optimal xy and axial settings for imaging at 1 airy disk. 

 
 

 

2. Available diode laserlines: 405 nm, 488 nm, 561 nm, 635 nm. 

  

 

 

XY resolution = 0.46*em/NA ; Z-resolution = 1.4*n.em/NA2; Nyquist sampling criterion set to 2.3x; calculated for airy disk = 1;  em (stokes ~15 nm) used for calculation 

Leica SPE-II resolution table (lateral)  min pix size (nm, pinhole= 1 airy disk) 

 N.A 440055  nnmm  448888  nnmm  556611  nnmm  663355  nnmm  

10x ACS apo 0,3 280 340 387 433 

20x ACS apo cs 0,6 140 170 193 217 

40x PL APO  OIL 1,4 60 73 83 93 

63x ACS APO OIL 1,3 65 78 89 100 

available: 
     

10x PlanFluotar  0,4 210 255 290 325 

20x PlanFluotar  HC D1 0,5 168 204 232 260 

63x HCX Pl APO CS water 1,2 70 85 97 108 

100x HC PLAN APO OIL CS 1,4 60 73 83 93 

 
     

Leica SPE-II resolution table (axial) 
 

min Z step  (nm, pinhole= 1 airy disk) 

 N.A 405 nm 488 nm 561 nm 635 nm 

10x ACS apo 0,3 2849 3460 3934 3118 

20x ACS apo cs (air) 0,6 712 865 984 779 

20x ACS apo cs (glycerol) 0,6 1047 865 984 779 

20x ACS apo cs (oil) 0,6 1076 865 984 779 

40x PL APO  OIL 1,4 198 159 181 143 

63x ACS APO OIL 1,3 229 184 210 166 

available: 
     

10x PlanFluotar  0,4 1603 1946 2213 1754 

20x PlanFluotar  HC D1 0,5 1026 1245 1416 1122 

63x HCX Pl APO CS water 1,2 237 216 246 195 

100x HC PLAN APO OIL CS 1,4 198 159 181 143 
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Useful links to tools for imaging:  
Spectraviewers:  

 Pubspectra (George McNamara) 

 Spectraviewer (Invitrogen/Life sciences ) 

 

Software links:  

 Collection compiled by Prof. Fabio Grohovaz at San Rafael University, Milan (It) 

 Bioimage XD 

 Fluorender  

 Cell Profiler 

 Farsight (cell segmentation)  

 VisBio 

 BioView3D 

 

 

 

http://home.earthlink.net/~pubspectra/
http://www.invitrogen.com/site/us/en/home/support/Research-Tools/Fluorescence-SpectraViewer.html
http://www.sanraffaele.org/58226.html?page=9
http://www.bioimagexd.net/
http://www.sci.utah.edu/software/46-documentation/137-fluorender.html
http://www.cellprofiler.org/
http://www.farsight-toolkit.org/wiki/Main_Page
http://www.loci.wisc.edu/visbio/
http://www.bioimage.ucsb.edu/BioView3D

